LHCSA Statistical Report and Registration Forms on UDCS
Instructions

Please see Attachment A at the end of this document — it contains descriptions to all items on the tool bars
located on the top of the Report Manager worksheets.

General Information:
e Enter information in the blank white fields. All other fields (pink, lavender, and brown) are read-only
fields.
e Some fields are required. If they are left blank, you will not be able to submit the report
e Some fields require a Yes or No answer. You must double click on the blank field and choose Yes or
No from the box.

The Control Data Form
The Control Data Form is part of the Report Manager Software, and collects information about your

organization that not only identifies you but enables the submission and certification of your report as well as
the successful transfer of your data to a data repository.

When you open the report, you will receive a pop up box that requests that you fill in the Control Data Form.
You must fill in the Control Data Form prior to submitting the report.

85 Control Data Validation Message — O o0

Required fields for Control Data Form are not filled.
Please fill out the values in appropriate required fields on Control Data Form. i
Do you want to open Control Data Form now? i

Yes No View Details
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Report Control Data Form

Configuration Information

Class Code Line Number

Submission Type : | o| |1oos | |ANNUAL |
Submission Year : | 0| [1010 | [2017 |
Submission Period : | o] 1011 | |00 |
DN : | o fioos || |
Submitter ID : | o| [1000 | [1205L001 |
Region ID : | o| |1oo3 | |1s |
Region Name : | o| |1ooz | | |9
Name of Organization : | o| |1o | |TEST ORG 3 FOR 8.10.18 VERSION OF FORMS |
Begin Date : | o [34 | 0170172017
End Date : | o [35 | 123172017
Contact Person

Class Code Line Number
e | o
Tite: [ 4000 f4 | @
Telephone Number : | 54000| |5 | | |o
Fax Number : | 54000] |6 | |
E-mail Address : | 54m| |7 | | |o

Mailing Address

Street Address :
City :
State :

Zip Code:

The configuration information section will be filled in for you. You only need to fill in the Contact Person
and Address sections.

Class Code Line Number

| s4000] i1 | @
| s4000| |12 | @
| s4000] 13 | @
| s4000] [14 | |
‘ Validate ‘ ‘ Save ‘ | Cancel |
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Form LSR1 - Agency Form

Form LSR1 - Agency Form collects agency location, contact information and other information.

LSR1 Agency Contact Information Form

L5R1 Agency Information Form

10000 10001 10002

License Mumber 99991001
Mational Provider |dentification Number (not required) | 00002 | 123444
Agency Mame | 00003 |ZTest LHCSA
Street Address | 00004 | 25 Lake Street
City Albany
State MY
Zip 12206
Agency Phone Mumber 489-849-999%
Contact Person Name Jane Smith
10 | JSmith@ZTest.com

ey

w

Contact Person Email

Please Note: If this Agency is an ALP LHCSA that EXCLUSIVELY serves ALP patients you

must complete the following forms: R
LSR1 Agency Information Form 00012
LSR 2 Patient Form (the first 3 questions only) 00013
LSR9A, LSRIB, LSROC Workforce Forms 00014
LSR10 Registration Form 00015

Did this Agency serve patients during the report year? | 00016 |Yes

Does this Agency EXCLUSIVELY serve patients in an Assisted Living Program (ALP)? | 00017
Does this Agency operate a Home Health Aide Training Program? | 00018

Daoes this Agency operate a Personal Care Aide Training Program? | 00019

Does this Agency serve waiver program (NHTD or TBI) patients? | 00020

Are there any employees of this Agency that are represented by a collective bargaining
agreement?

Is this Agency a Fiscal Intermediary (FI) for the Consumer Directed Personal Assistance
Program (CDPAP)?

If yes, is this Agency EXCLUSIVELY a FI for CDPAP? | 00023
OR s this Agency's FI a separate line of business from your Home Care line of business? | 00024

Agency and Contact Information Section
All fields in this section, except for NPl number, are required fields. You will not be able to submit the
statistical report if this information is not filled in.

Additional Information Fls for CDPAP Sections
The fields in this section require yes or no responses. You must double click on the blank space and the box
with the choices will appear.
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o=l YESMO ol

Search || |

Name
Yes
No

Current value for cell [
{no value has been assigned} Ok Cancel

Important Note for ALP LHCSAS - If your LHCSA answers “Yes” to the question “Does this Agency
EXCLUSIVELY serve patients in an Assisted Living Program?”” you are only required to submit:

e Form LSR1 — Agency Information Form

e Form LSR2 — Patient Form — the first three questions only

e Forms LSROWFA, LSROWFB, LSROWFC — Workforce forms A, B, and C

e Form LSR10 - LHCSA Registration Form.
You are also required to submit the 2017 ALP LHCSA Statistical Report on the HERDS application of the
Health Commerce System.

Please note that if your agency is a LHCSA that serves ALP residents and also serves patients in the

community, select no, and complete and submit all forms of this survey. Additionally, you must complete and
submit the 2017 ALP LHCSA Statistical Report on the HERDS application of the Health Commerce System.
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Form LSR2 — Patient Form

Form LSR2 - Patient Form collects patient demographic information, including discharges and referrals.

LSR2 Patient Form
LSR2 Patient Form Patients/LOS | Referred From | Discharged To

Census on December 31 of the Report Year | 00001

Total Cases | 00002
Unduplicated Patient Count | 00003
00999

Total Unduplicated Patient Count from Services by
County Forms - LSR7

1-60 Days of Stay
61-120 Days of Stay | 00005

121 + Days of Stay
TOTAL

Hospitals
Physicians | 00013

Self/Family/Friends | 00014

Mursing Homes | 00015

CHHAs | 00016

LTHHCPs | 00017

LHCSAs | 00018

Hospices | 00019

Adult Care Facilities | 00020

CasSA/Local Social Services District | 00021
MLTC/MCOs | 00022

Lacal Health Department | 00023

Adult Protective Services | 00024

Death | 00025
Other | 00026
TOTAL | 00030

Some of the totals on this form are automatically calculated — they are the lavender fields.
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Patients Section

Enter information for Patient Census (required). Enter the patient census as of December 31 of the report
year (12/31/2017). Patient Census means the actual number of individual patients receiving services on
12/31/17.

Next, enter the total number of cases in the Total Cases field (required). A case is an episode of care with a
start date (admission) and an end date (discharge). Multiple types of service may be provided during an
episode of care. For an episode of care to count as a case for this report the admission date must be in this
reporting year or prior year(s), and the discharge date must be in this reporting year or the patient must still be
receiving services at the end of the reporting year. A patient who has been seen only to be assessed for
personal care services should not be counted as a case and these visits should not be reported.

A patient sometimes represents more than one case. However, DO NOT count a patient as a new case if any
of the following conditions apply:
e The patient’s age category was changed during the report year
e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.
e The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Enter the Unduplicated Patient Count in the next field (required). This is the total number of discrete
individual patients that your agency has served in the year, regardless of the number of admissions and
discharges that patient may have had. A patient is only counted once regardless of the number of cases they
represent.

To recap, if a patient is receiving care on 12/31/2017 they will be included in the patient census count. If they
had two admissions during the year, they will count as two cases but as only one unduplicated patient.

Validation Edit - The unduplicated patient count entered on LSR2 must match the total of the unduplicated
patients reported on forms LSR7 — Services by County Form. This total is displayed in the first section of
LSR2 — Patient Form.

Length of Stay Section

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or
case. Length of stay should be calculated from the date the patient was initially admitted for an episode of
care, regardless of the year of admission, to the date they were discharged. For example, if a patient was
admitted on 12/30/2016 and discharged on 1/10/17 her LOS is 12 days. Count the 2 days in 2016 and the 10
days in 2017 to arrive at a 12 day LOS. Patients that were discharged to a hospital or RHCF and readmitted to
the agency within 30 days with the same illness or diagnosis should NOT be counted in the length of stay
section.

Referrals and Discharges Section

The next section collects patient referral and discharge information. In the “Referred From” column enter the
number of cases served by your agency that have been referred from each of the designated sources regardless
of their start of service date. This means that if you are serving a case in 2017 that was referred to your agency
in 2016, that case should be counted. Patients that were discharged to a hospital or RHCF and readmitted to
the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section.
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In the “Discharged To” column enter the number of cases discharged during the reporting year to specific
destinations.

Validation Edit - The total number of discharges calculated from the LOS entries must match the total
number of discharges calculated from the “Discharged To” destination section.
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Form LSR3 and LSR4 — Revenue Form

Form LSR3 and LSR4 — Revenue Form has two sections (formerly two forms that have been combined onto
one report worksheet on UDCS):

LSR3 — Contract Revenue Form collects information about revenue received from contracts with other
agencies to perform services for their patients, or provide equipment to their patients.

LSR4 - Direct Revenue Form collects data on revenue from services provided to patients directly served by
your agency (i.e. services are not provided on behalf of another agency). Direct services may include private
pay, commercial insurance, and worker’s compensation cases.

LSR3 and LSR4 Revenue Form

L5R3 and LSR4 Revenue Form
34000

Did your Agency perform services, or provide equipment to
patients during the report year?

Mursing Services

Private Duty Mursing Services
Community Health Work Services
Medical Social Work Services

Case Management/Care Management Services

Physician Services
Audiology, Mutrition, and Therapy Services

Home Health Aide Services

Personal Care Aide Services
Homemaker and Housekeeper Services | 0010
IV Infusion Therapy Services | 0011
HHA Training Program | 0012

PCA Training Program | 0013
Waiver Services | 0014

Telehealth Monitoring | 0015
Assistive Technology | 0016
Durable Medical Equipment | 0017
Other Services | 0018

TOTAL | 0020 1] 0 $0
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LSR4 - Direct Services Visits Hours Gross Revenue

Enter the number of direct visits or hours and revenue for
each service:

Mursing Services | 0021
Private Duty Mursing Services | 0022
Community Health Work Services | 0023
Medical Social Work Services | 0024
Case Management/Care Management Services | 0025
Physician Services | 0026
Audiology, Mutrition, and Therapy Services | 0027
Home Health Aide | 0028
Personal Care Aide | 0029
Homemaker and Housekeeper Services | 0030
IV Infusion Therapy Services | 0031
HHA Training Program | 0032
PCA Training Program | 0033
Waiver Services | 0034
Telehealth Maonitoring | 0035
Assistive Technology | 0036
Durable Medical Equipment | 0037
Cther Services | 0038
TOTAL | 0040 (V] 1] $0

Some of the totals on this form are automatically calculated — they are the lavender fields.

Please note that data on Nursing Services is collected as visits, instead of hours. If your agency records
Nursing Services in hours, please count 2.5 hours as 1 visit.

Contracted Services Section

Begin by answering the Perform Services Question - If your agency DID NOT perform services for, or
provide equipment to, the patients of other agencies under contract during the report year, answer the first
question “no” and move down to the Direct Services section of the form. You may leave the columns blank
and do not need to enter Os in these columns.

If your agency DID perform services for or provide equipment to the patients of other agencies under
contract, enter “yes” for the first question. Enter the number of contract hours and revenue by the type of
service if you have contracted with another agency, usually a CHHA or an MLTC plan, to provide service on
their behalf.

Direct Services Section

Enter the number of hours and revenue by the type of service.

If your agency did not provide any services directly to any patients, leave the columns blank (you do not have
to enter 0s).

For both the Contracted Services and the Direct Services - the Gross Revenue is the total revenue received
for the services or equipment provided before any deductions or allowances.
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LSR5 — Cost Form

LSR5 — Cost Form - collects data on costs for providing services to patients. Costs are divided into direct
and indirect costs.

Direct costs are costs that are clearly associated with the provision of home care patient services. Examples of
direct costs are staff wages, transportation costs, consumable supplies such as gloves and masks, and the cost
of providing in-service training to aides.

LSR5 Cost Form

Mursing Services

Private Duty Mursing Services
Community Health Work Services

0001

0002

0003

Medical Social Work Services | 0004

Case Management/Care Management Services | 0005
0006
0007
0008
0009

Physician Services

Audiology, Nutrition, and Therapy Services
Home Health Aide Services

Personal Care Aide Services

Homemaker and Housekeeper Services | 0010
IV Infusion Therapy Services | 0011

HHA Training Program | 0012

PCA Trainig Program | 0013

Waiver Services | 0014

Telehealth Monitoring | 0015

Assistive Technology | 0016

Curable Medical Equipment | 0017

Other Services | 0018

TOTAL DIRECT COSTS | 0020 $0
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Indirect costs are fringe benefits and payroll taxes as well as costs for activities and materials that are used by
the entire agency.

The indirect costs are broken out by fringe benefits and other indirect costs, such as administrative and
general costs, capital and related costs, and other operating costs.
e Administrative and General costs are expenses for activities and materials that are used to administer
your business. Examples are rent, utilities, and office supplies.
e Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the
agency, etc.

Indirect Costs
Fringe Benefits and Payroll Taxes:
Social Security | 0021
Insurance - Life/Health | 0022
Pension and Retirement | 0023
Workers Compensation | 0024
Unemployment Insurance | 0025
Disability Insurance | 0026
supplemental Wages | 0027
Employee Physicals | 0028
Other | 0029
Other Indirect Costs
Administrative and General Costs | 0030
Capital and Related Costs | 0031
Other Operating Costs | 0032
TOTAL INDIRECT COSTS = 0040 $0
TOTAL DIRECT + INDIRECT COSTS | 0050 $0

Some of the totals on this form are automatically calculated — they are the lavender fields.

Send questions to hcstatrpts@health.ny.gov pg. 11



LSR6 — Staff and Wages Form

LSR6 — Staff and Wages Form - collects information by staff type for full time and hourly staff at two
different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe
benefits.

Average | LowestHourly | Highest
Countof Full | Countof | CountofFull | Countof e, . ccwns | Total Hours | Total Wages | Total Fringe | 'Wa9e%* Hourly | Rate Paidfor  Hourly Rate
LSR6 Staff and Wages Form Time Staff on = Hourly Staff | Time Staff on = Hourly Staff N N Fringes . .
Aor 1 Apr 1 Oct1 Oct 1 issued for the Year for the Year Benefits (Calculated) Compensation | each Staff Paid for each
Pr on Apr on culate (Calculated) Type Staff Type
60000 60001 60002 60003 60004 60005 60008 60006 60007 60009 600010 600011 600012 600013

Enter the information for each of the
following staff types:
Administrators | 00001
Other Administrative Staff | 00002
Nursing Supervisors | 00003
RNs | 00004
LPNs | 00005
Private Duty Nurses | 00006
Community Health Workers | 00007
Medical Social Workers | 00008
Case Managers/Care Managers | 00009
Physicians | 00010
Audialagists, Nutritionists, and Therapists | 00011
Home Health Aides | 00012
Personal Care Aides | 00013
Homemakers and Housekeepers | 00014
Other Staff | 00015
TOTAL | 00020

Some of the totals on this form are automatically calculated — they are the lavender fields.

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition
of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per
month.

Enter the number of W2s issued, total hours worked, total wages paid, and total fringe benefits paid for each
staff type. The amount of wages plus fringe benefits will be calculated in the first lavender column. The
second lavender column will divide the total wages and fringe benefits by the total number of hours to
calculate an average hourly wage. In the next two columns, enter the lowest hourly rate paid and the highest
hourly rate paid for each staff type.
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LSR7- Services by County Form

LSR7 — Services by County Form - collects data on services provided by county. There is a sheet for each
county in New York State, in alphabetic order. The LSR7 worksheets were put at the end of the list of
worksheets on the left hand side of the screen.

|
Unduplicated . . . . Nurse Family | Nurse Family
LSRY Services By County-Albany Ct/New cai:;uz';“' :r::'::’:;:; Cases Age 21-64 V:;:";':"J T | Caser :’:‘E hge J::i'\':: e, cas:;::ﬂale F:,',:',‘:" :;";; Partnership | Partnership
Admissions Cases Visits
70000 70001 70002 70003 70004 70005 70006 70007 70008 70009 70010 70011 70012
Albany County
Unduplicated Patient Count | 01001
Number of new admissions during the reporting year | 01002
Enter Cases, Visits, and Hours for each service type Cases Under 21  Visits Under 21 Cases 21-64 Visits 21-64 Cases Male 64+ Visits Male 64+ Cases Female 64+ Visits Female 64+  Cases NFP Visits NFP
MNursing Services | 01003
Hours Female
Cases Under 21  Hours Under 21 Cases 21-64 Hours 21-64  Cases Male 64+ Hours Male 64+ Cases Female 64+ 64 Total Cases Total Hours

Private Duty Mursing Services | 01004

Community Health Work Services | 01005

Medical Social Work Services | 01006

Case Management/Care Management Services | 01007
Physician Servicess | 01008

Audiclogy, Nutrition, andTherapy Services | 01009
Home Health Aide Services | 01010

Personal Care Aide Services | 01011

Homemaker and Housekeeper Services | 01012

IV Infusion Therapy Services | 01013

Waiver Services | 01014

Telehealth Monitoring | 01015

Assistive Technalogy | 01016

Dubable Medical Equipment | 01017

Other | 01018

Total for County (excludes Nurses) | 01030

Some of the totals on this form are automatically calculated — they are the lavender fields.

Enter the total number of unduplicated patients, and the number of new admissions during the report year for
each county that your agency provides services.

An unduplicated patient is an individual who has received at least one episode of care and may have
received more than one. Regardless of the number of episodes in the reporting year, the individual is only
counted once.

New admissions are patients that have been admitted to the agency during the reporting year. Patients that
were admitted at a previous time during the report year (or in prior years) and discharged and were admitted
again during the report year should count as a new admission at the time of admission, with the following
exceptions:
DO NOT count a patient as a new admission if any of the following conditions apply:
e The patient’s age category was changed during the report year
e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.
e The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Nursing services captures data about nursing services provided to patients in the selected county. The data is
then broken out by cases and visits, age, and gender (for ages 64+). If your agency records Nursing Services
in hours, please count 2.5 hours as 1 visit. In addition, if your agency is part of the Nurse Family Partnership
— the number of nursing service cases and visits should be recorded in the selected county. The Nurse
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Family Partnership is a program in which nurse home visitors work with low-income young women who are
pregnant with their first child, helping these vulnerable young clients achieve healthier pregnancies and births,
stronger child development, and a path toward economic self-sufficiency.

All other services provided to patients in the selected county must be recorded below the Nursing Services
row. The data is then broken out by cases and hours, age, and gender (for ages 64+).

A case is an episode of service with a start date (admission) and an end date (discharge). Multiple services
may be provided during an episode of service. For an episode of service to count as a case for this report the
admission date must be in this reporting year or prior year(s), and the discharge date must be in this reporting
year or the patient must still be receiving services at the end of the reporting year. A patient who has been
seen only to be assessed for personal care services should not be counted as a case and these visits should not
be reported.

A patient sometimes represents more than one case. However, DO NOT count a patient as a new case if any
of the following conditions apply:
e The patient’s age category was changed during the report year
e The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with
the same illness or diagnosis. In this instance the discharge should not be counted.
e The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently
established.

Validation Edit: If you enter an amount in the “Cases” column you must enter an amount in the
corresponding “Hours” column. Also, if you enter an amount in the “Hours” column, you must enter an
amount in the corresponding “Cases” column.
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LSR7A — Wellcare Form

LSR7A — Wellcare Form - collects data about wellcare services provided to patients. Wellcare services
include services which have as their primary purpose the prevention of illness and obtaining optimum health
for their recipients. Examples of such services are nurses performing lead screening assessments, providing
maternal and child health education, or following up on communicable diseases.

Only County-Operated LHCSASs that provided wellcare services need to complete this form.

LSR7A Wellcare Services

Visits/Hours - Visits/Hours -
Male Female

74000 74003 74005

LSR7A Wellcare Services

Less than 1 Year of Age | 00002
1-5 Years of 4ge | 00003

6-18 Years of Age | 00004
19-20 Years of 4ge | 00005
21-35 Years of Age | 00006
36-64 Years of Age | 00007
85+ Years of Age | 00008

Total

Less than 1 Year of Age | 00012
1-5 Years of Age | 00013

6-18 Years of 4ge | 00014
19-20 Years of Age | 00015
21-35 Years of Age | 00016
36-64 Years of Age | 00017
B85+ Years of Age | 00018

Towl| o020 [0

Some of the totals on this form are automatically calculated — they are the lavender fields.
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Nursing services captures data about nursing services provided to patients in the selected county. The data is
then broken out by cases and visits, and gender. If your agency records Nursing Services in hours, please
count 2.5 hours as 1 visit.

Private Duty Nursing Services captures data about nursing services provided to patients in the selected
county. The data is then broken out by cases and hours, and gender.
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LSR8 — Contracts Form

LSR8 — Contracts Form - collects information on your agency’s contracts to provide services on behalf of
another agency.

|
e paenc e | | o | b e
80000 80001 80002 80003 80004 80005 80006 80007
Yes/No
Did your agency provide Aide services for 2008
patients of another agency under contract?
Enter Contract information for services License/Op HHA Service  Rate Paid for  PCA Service  Rate Paid for
performed for other agencies/facilities Cert Number brEE Hours HHA Services Hours PCA Services

Contract No. 1| 0001
Contract No. 2 | 0002
Contract No. 3 | 0003
Contract No. 4 | 0004
Contract No. 5 | 0005
Contract No. 6 | 0006
Contract No. 7 | 0007
Contract No. 8 | 0008
Contract No. @ | 0009
Contract No. 10| 0010
Contract No. 11| 0011
Contract No. 12 | 0012
Contract No. 13 | 0013
Contract No. 14 | 0014
Contract No. 15 | 0015

If your agency did not have any contracts to provide services for another agency, answer No to the first
question, and you are now finished with this form.

If your agency did have contracts to provide services on behalf of another agency, answer Yes to the first
question, and enter the information for the contract(s).

If it is available, enter the license number/operating certificate number for the agency with whom you are
contracting. CHHAs and Hospices will have operating certificate numbers. Other organizations may not have
an operating certificate number. Enter N/A if the organization does not have an operating certificate or
license number.

Operating Certificate numbers can be found in the Home Care section on the Profiles webpage
https://profiles.health.ny.gov/home_care/index. Hover the mouse at the Home Care tab and you will see
several ways to search for an agency. Once you find the agency you are looking for, click on the overview tab
and open the administration section.

Enter the number of HHA and PCA hours of service you provided under this contract and the amount your
agency was paid per hour of service.

If the requested information for a given contract changed during the reporting year, enter it as two or more
separate contracts.
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LSROWFA — Workforce Form A

LSROWFA — Workforce Form A - collects information on admissions and the number of cases by
authorized hours per week for all services.

LSROWFA Workforce Form A

LSROWFL Workforce Form 4

90001

How many times during this
reporting year was your agency 0001
closed to admissions?

How many cases did your agency
have during the report year where
you were unable to fill the total hours
contracted?

How many cases was your agency
unable to accept on April 1 and Oct 0003
1 of the report year?

1-10 hours per week
11-20 hours per week 0011
21-30 hours per week 0012
31-40 hours per week 0013
40+ hours per week 0014

Mo, of Live-in Aide Cases

An agency is closed to admissions when the agency is not accepting any new patients.
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LSROWEFB — Workforce Form B

LSROWFB — Workforce Form B - collects information on number of staff employed and assigned to cases,
and the number of open positions at two points during the year. This form also collects the number of staff
that have been employed by your agency for the full report year and the number of staff that have left your
agency during the report year.

]
Count of Staff
Count of Staff | Count of Staff Count of Count of Staff Count of Staff | that left the
Employed on Assigned Open Employed on Count of Staff | Count of Open Employed for | Agency for
LSRYWFB Workforce Form B April 1 (F Ca Avril | Positi Oct1(F Assigned Positions on the full Report
pri rom ses on Apri ositions on TOM | s on Oct 1 Oct1 e full Repol any reason
LSRé) 1 April 1 LSRé) Year during the
report year
91001 91002 91003 91004 91005 91006 91007 91008 91009 91010
Staffing
Enter the information for each of the following
staff types:

Administrators | 00001

Other Administrative Staff | 00002
Mursing Supervisors | 00003

RNs | 00004

LPMNs | 00005

Private Duty Murses | 00006

Community Health Workers | 00007
Medical Social Workers | 00008

Case Managers/Care Managers | 00009
Physicians | 00010

Audiologists, Nutritionists, and Therapists | 00011
Home Health Aides | 00012

Personal Care Aides | 00013
Homemakers and Housekeepers | 00014
Other Staff | 00015

The number of staff employed on April 1 and October 1 is totaled (count of full time staff plus count of hourly
staff) and forwarded from form LSR6 — Staff and Wages Form.

e Enter the number of staff assigned to cases on April 1 and October 1.

e Enter the number of Open positions on April 1 and October 1. A position is considered open when an
agency has advertised for a position but it is not filled. This includes both hourly and full time
positions.

e Enter the number of staff (full time and hourly) that have remained employed by your agency for the
full report year or more.

e Enter the number of staff (full time and hourly) that have left your agency (no longer employed by
your agency) for any reason during the reporting year. This is a count of workers who left their
position for any reason — voluntary or involuntary — excluding promotions.
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LSRIWFC — Workforce Form C

LSROWFC — Workforce Form C - collects employee benefit information for four types of employees, and
non wage supports for all staff.

LSRSWFC Workforce Form C

LSROWFC Workforce Form C

HHAs

Hoememakers
and
Housekeepers

92001

How many employees are
enrolled in employer-provided
health insurance as of October
17

How many employees have paid
sick/vacation leave as of
October 17

How many employees have
access to employer sponsored
retirement plans as of October
1?

How many employees have
short term disability insurance
which the agency pays at least
part of the premium as of
October 17

How many employees have filed
Workers Compensation claims
during the reporting year?
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Transportation Support
Childcare Support
Mentoring

Benefit Assistance
Scholarships

Other

Does the agency pay increased
wages for employees filling
cases on weekends, holidays,
or for complex cases?

Does the agency offer
employer-provided health
insurance?
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LSR10 - Registration Form

LSR10 — Registration Form - collects an attestation that indicates the LHCSA is currently operational and
serving patients. If the LHCSA has opened in the past year, you can report on the form that the LHCSA is not
yet operational and is currently not seeing patients.

The Administrator or Operator must request that the LHCSA be registered with the Department of Health for
the upcoming calendar year.

LSR10 LHCSA Registration Form

LSR10 LHCSA Registration Form Response
100000 100001 100002

Today's Date 00001
LHCSA Operator Mame 00002
LHCSA Administrator Name of Record, as it appears on the Health Commerce System

Did this LHCSA provide patient care services during the report year of 1/1/2017 - 12/31/20177
Did this LHCSA provide patient care services during any portion of 20187 00005
Does this LHCSA intend to provide patient care services in 20197 00006

Has this LHCSA been open less than one year from today's date and has not served patients during this timeperiod?

Date LHCSA Opened

00007
00008
Has this LHCSA received payment for Nursing, HHA, or PCA services during the report year of 1/1/2017 - 12/31/20177

Mo Licensed Home Care Services Agency shall be permitted to operate, provide nursing, personal care aide services or
N N 00010
home health aide services

or receive payment for such services from any payor unless it is registered with the NYS Department of Health.
Do you wish to register this LHCSA with the NYS Dept of Health for the period 1/1/2018-12/31/2019? 0012

By answering yes, | attest that all of the above responses are true and correct to the best of my knowledge. 00013

Completed by (Administrator or Operator): 00014
I A

The deadline to submit the Registration Form (LSR10) for the period beginning January 1, 2019 is November 16, 2018. 00015

FaihlehnlunitmmlhgishaﬁmFonnlI.SIl1ll}byﬂ?u?ntu'lﬁ,mlsuillmltinapmaltyofﬁmhlﬂed 00016

dollars ($500) for each month or part thereof that the LHCSA is in default.

A LHCSA will not be allowed to register for the following registration period unless it submits any unpaid late fees. 00017

The Department shall institute proceedings to revoke the license of any LHCSA that fails to register for two annual periods 00018
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Validating the Statistical Report

You may, at any time, Validate the Sheet you are working on, or validate the entire Report. You must
validate the report before submitting it.

Go to the top tool bar and click on the drop down box next to the green arrow.

RS ED L E vaupate current worksieer - YB3 BS54 © @) ENE] Q

N
‘VALIDATE ENTIRE REPORT

FZHEDHE

LHCSA STATISTICAL REPORT

BR 5O 5 Q

ME - 1 : CENTRAL : 2017 : AQO

iHCBS T

You can validate a worksheet at any time. You can also refresh the validation after it’s been done once by
clicking the refresh circle in the details portion of the report. Because there are so many worksheets, it may
be easier to validate each worksheet once you’ve finished it. The results of the validation are in a table in the
details section of the worksheet. The message that says “Rule Passed Validation” is only referring to the cell
you are on — not the whole worksheet.

Details

Worksheets Open Calculations Text Transfers Validation Results Submission Output

RULE PASSED VALIDATION
If a value is entered under cases, then a value must be entered under hours.
{70005.1904} [NZNZ] {70006.1904}

Identifier Level Error Left Value Operator Right Value Rule
LSR7 Clinton Critical ] NZMZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical O NZMZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical | NZMNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical |:| NZNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical NZNZ If a value is entered under cases, then a value must be entered under hours.
s S M IR e B = Tt e e
LSR7Y Clinton Critical | NZNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical O NZMZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical Il NZMZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical O NZMNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical Il NZNZ If a value is entered under cases, then a value must be entered under hours.
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To see if you have any cells with errors — click on the column header that says error — and the list will sort and
all of the checked boxes will come to the top of the list. In the screenshot below for form LSR7, the user
made entries made in the “Cases” column and no corresponding entry in the “Hours” column . After clicking
validate worksheet, and clicking the error column header — the errors show up on the list.

Private Duty Nursing Services | 01904
Community Health Work Services | 01905

Medical Social Work Services | 01906 23
Case Management/Care Management Services | 01907
Physician Servicess | 01908 86 _

Bl s R e ATl e m oo - | AAAAR

<

Footnotes

Cell [70004.1908] : Datatype [Systern.Int32] : Mask [NO] : ReadOnly [Mo] : Value []
Details

Worksheets Open Calculations Text Transf Validation Results Submission Output
RULE PASSED VALIDATION

If a value is entered under cases, then a value must be entered under hours.
{70009.1903} [NZNZ] {70010.1903}

Identifier Level Left Value Operator Right Value Rule

LSRT Clinton Critical 23 NZNZ 0 If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical 86 NZNZ 0 If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical O NZNZ If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical |:| NZNZ If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical NZNZ If a value is entered under cases, then a value must be entered under hours.
I:-__
LSRT Clinton Critical NZNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical |:| NZNZ If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical O NZNZ If a value is entered under cases, then a value must be entered under hours.
LSR7 Clinton Critical O NZNZ If a value is entered under cases, then a value must be entered under hours.
LSRT Clinton Critical O NZNZ If a value is entered under cases, then a value must be entered under hours.

If you have passed the validation edits you will have no error boxes checked and get a green message that
says Rule Passed Validation for each cell you choose.

Finalizing the Statistical Report

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on
Finalize Report.

7 5 E T [ EX [ vaupate current woRksHEET - ‘ ©@® £sfg Q

A message will come up asking if you are sure you want to save and finalize. Click Yes.
A second message will come up directing you to correct errors (if there are any) or letting you know that the
report has been finalized.

Select a location to save your Finalized Report.
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Your report is now ready to be submitted to the Healthcare Financial Data Gateway.

Submitting the Finalized LHCSA Statistical Report to the Healthcare Financial Data Gateway

1. Login to the HCS.
2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the
Healthcare Financial Data Gateway main page.

% Healthcare Financial Data Gateway Wekcome Jona  Muftaker

EVAL EVAL EVAL

Home Software Submissions Publications Reports Administration

|»

Welcome to the Healthcare Financial Data Gateway
The navigation bar above contains selectable tabs for each functional ares of the apphcaton and is used to navigate throughout the application.
Please read the descriptions of these areas below:

Software: The “Soltware” tab 15 used to download the Cost Report software and supporting documentation. tems sefected for
download will be saved as a 2p file

Submissions: The "Submissions” tab can be used to do any of the following

« Sybmat your completed and fnalized Cost Report
o View the details of past submussions
« Contify 3 previously submated Cost Repont

Publications: The Publications” tab 5 used to download addtional information distnbuted by the Department of Health that is not
deroctly related to the distribution of the Cost Repont scltware

Reports: The ‘Reports” 1ab is used to access 3 downloadabie hstory of submssion and certification detads for the Cost Reports

Administration: The “Ademnistration” tab can be used to do any of the following

o Grant permressions to the apphcations

« Manage Roles

* Set Submission CutOff

» Upload Software, Reports, and Supporting Documentation
» Upload Cedtifications

3. Click the Submissions tab — the Submissions page will display

f% Healthcare Financial Data Gateway Welcome John F Huffaker
- - Home | Contact | Request Access | Help

b

Home Software Submizgions Publications Reports Adminiztration
SUBMISSIONS
Select Cost Report And Organization
Submission Type: LHCSA j Organization: 00 Test LHCSA (D00000LC) j Search
82014 NYS Department of Health System Information
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4. Select LHCSA as the Submission Type and your organization from the Organization list and then
click the Search button. The Submission page will be expanded.

& Healthcare Financial Data Gateway Wieleome John P Huffaier
>

New York State Department of Health Home | <Contact | ReguestAccess | Help
Home Software Submizzions Publications Reports Administration
SUBMISSIONS
Select Cost Report And Organization
Submission Type: LHCSA j Organization: 00 Test LHCSA (000000LC) j Search

New Submission

Email: john.huffaker@heatth.ny.gov [Update email address}  Refrzsh Email

Uplead File: Browse. .. | No file selected.

Submit

Submiz=ion History

Report Period : 2017-Annual
. R e T = R
--Year | Period

12017 Statewide 08202018113309 08-20-2018 12:47:21 John P Failure Detsil
L Annud Huffaker
Statewide 08202018113309 08-20-2018 11:34:30 John P Success Detail Dommiond
Huffaker e
Statewide 08-20-2018 11:30:59 John P Failure i
Datail
Huffaker _J

5. Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA
Statistical Report. It will have a .pnp file extension.

6. Once you have selected the file to submit, click the Submit button.

7. The Submission History section of the Submission page will be updated to reflect the status of the
submission.

8. A confirming email message will be sent to the email address listed in the New Submission section of the
Submission page.
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Attachment A — Report Tool Bar items

Worksheets

Worksheets

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application
window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view
that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to
collapse or expand the panel. Use the "Windows™ menu item to organize your Worksheets in the Matrix
Panel.

Title Bar
Title Bar

The Title Bar is located at the very top of the window and will display the name, version and software build
number, followed by the name of the active matrix table if a table is currently open.

ﬂ Universal Data Collection System - Version 5.0.0 - Build 20180306:152943 - [FIDA_001_010]

Menu Bar

UDCS Menu bar
File Edit View Configure Action MNotes Windows Search Help

The following Help Topics will guide you through the menu bar functionality.

File
The File Menu.
 File | Edit View Configure |

Report Manager Ctri+R
New Ctrl+N
Open Ctrl+0
Save Ctrl+S
Save Copy To ... I
Print rol
Close Report i
Exit Program i
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Report Manager: Select Report Manager to return to the Report Manager.
New: This command will start a new Report

Open: This command will enable you to open an existing Report

Save: This will save the Report you are working on.

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location
that you choose.
Your working report location will remain in the default location: C:\ProgramData\UDCS\report

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel
document or a PDF document.

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or
check Select All to check all of the worksheets.

You will be prompted to save the export file to a location you choose. You can then open the file from this
saved location and print.

Close Report: Closes the Report. You will be prompted to save your data first.

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data
first.

Edit
The Edit Menu

Cut, Copy, Paste, Undo

Edit | View Configur
Cut  Ctrl+X
Copy Ctrl+C
Paste Ctrl+V

Undo Ctrl+Z

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel
to your Report with some limitations:

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to
numeric type cells.

2) You may not paste data into read only cells such as targets of formulas.

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If
the range size does not match, you will not be allowed to copy the data.
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For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has
read only cells, you will be alerted to adjust your range.

View

The View Menu

View | Configure Action Notes Windows Se

Report Type »
Worksheet Panel (Expand-Collapse) Alt+W

Previous Worksheet Alt+Up

Next Worksheet Alt+Down
Detail Panel (Expand-Collapse) Alt+D

Calculations (In Pop-Up Viewer)
Text Transfers (In Pop-Up Viewer)
Validation Results (In Pop-Up Viewer)

Submission Output (In Pop-Up Viewer)

Report Type: You can choose to Select All Worksheets to display all of the worksheets in the Report in the
Worksheet display panel.

For Reports that have multiple Report Types, you may choose to select only the worksheets from the
selected Report Type.

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to
collapse the worksheet panel
when you are working on a large worksheet and could use extra space to see more of the worksheet.

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to
expand the worksheets.

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets.

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works
similarly to
expand-collapse worksheets.

The following menu items will each open a window that will enable you to Export the data as a text file.
Calculations: A window will open that lists all of the mathematical expressions in the Report.

Text Transfers: Lists all of the Text Transfers in the Report.

Text Transfers consist of a value and a target. Once the value is entered, the target will
automatically get populated with the same value.
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Validation Rules:Lists all of the Validation Rules in the Report.
Validation Rules are conditions that must be met in order for the report to be completed
satisfactorily.

Submission Output: This is the XML output of the Report. It lists Report configuration information
as well as class code/line numbers and the values that were entered for them.

Configure

The Configure Menu

WConfigureW Action Notes
Control Data F2

Report Settings F3
Report Types F4

Control Data: Contains information that is required in order for the Report to be completed correctly and
allowed to be submitted.

All required Control Data fields must be complete. Required fields will have a red exclamation point next to
them.

When you open the Report, you will be alerted if the Control Data information is not completely filled out.

Report Settings / Report Types: These menu items are merely instructions to remind you what to do in the
event that you have created

your report using the wrong configuration information, such as the wrong Report Type or wrong Region. Click
on the File menu to

Start a New Report. Select the correct settings and then transfer your data from the incorrect Report to the
new Report.

Action

The Action Menu

Action | Notes Windows Seat
Validation Method »

Start Validating F5
Stop Valldating  Ctri+F5

Finalize Report Fé

Recalculate Formulas F7

Validation Method: Current Worksheet or Entire Report.

In order to Finalize the Report for Submission you must run it through the validation process. You can
validate to check only
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the current Worksheet or you can run Validation for the entire Report. You must Validate the entire Report in
order to
pass Validation and have a Finalized Report that is ready to submit.

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire
Report you can
select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time.

Notepad
The Notepad Menu

This is a scratch pad to keep notes and provide additional information while you complete your report. Click
the File menu and then Save to save Notes to your Report.
Use the File and Edit menu as you would a typical text editor.

Windows

The Windows Menu

Use the Windows commands to arrange the Worksheets to your satisfaction.
Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to
bring it to the front of the Report.

Windows | Search _
Cascade 1
Harizontal

Vertical
Close All
Worksheets »

Search

The Search Menu

Enter what you would like to search for in the Search box and click the Search button.
All results that match your Search criteria will be listed below. You may choose to Search
the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window.

Help
The Help Menu

View Documentation will open the Help File that you are currently reading.
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Help

View Documentation F1

About Universal Data Collection System (UDCS) F12

Click About to open the following window. This information contains details about the Report you have open
as well as the versions of the software and files being used.
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Icon Menu

Icon Menu

o8 Open the Control Data Form.

Start a New Report.

Open an Existing Report.

E Save the Report.

1]
H

* Close the Report.

Validate the Current Worksheet or the Entire Report.

8 Stop the Validation process.

Finalize the Report.

::;A Open Notepad.

@ Open the Previous Worksheet.
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@ Open the Next Worksheet.

Export the Worksheet as a PDF document.

Export the Worksheet as an Excel file.

Open the Search Window.
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